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ATTENTION! The detachable microphone must be used only together with the matched
Tango_Plus! The capsule MK255 and the preamplifier (Order number:
907144.5) are selected as pair by manufacturer and must not be devi-
ded! If used with other hardware with more than ± 2.5 V power supply, the
preamplifier will be damaged and warranty is lost!
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1 Design
Thank you for choosing the product Tango_Plus by SINUS Messtechnik GmbH. Please read this manual
carefully before using the measuring system. Tango_Plus is an integrating sound level meter designed
according to IEC 61672-1:2014, accuracy class 1 and immunity to interference group Z. It can measure also
1/1 and 1/3 octaves according to IEC 61260:2003. This is true for all configurations described in section 3.

NOTICE! Tango_Plus may perform measurements that require an official verification
of the calibration and that are legally binding.
(type approval applied)

ATTENTION! If Tango_Plus is used for legally binding measurements, only original
accessories shall be used.

We recommend you to perform several test measurements to get familiar with the instrument before using it
for important measuring tasks.

1.1 General information

The manual includes the following signs to indicate important information:

NOTICE! These are information on the efficient use and correct handling of the ana-
lyzer as well as additional information.

CAUTION! These instructions shall avoid any hardware damages or dangers for users.

ATTENTION! These instructions shall avoid any measurement mistakes, hardware da-
mages etc.

Please feel free to contact us for any questions on the functionality and operation of the instrument. Direct
your questions or requests on spare parts and accessories to the following address:

Address: SINUS Messtechnik GmbH
Föpplstraße 13
04347 Leipzig, Germany

Telephone: +49-(0)341-24429-33
Fax: +49-(0)341-24429-99
E-mail: info@soundbook.de
Web: http://www.soundbook.de
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1 DESIGN

1.2 Important notes

When measuring with the device, please consider the following notes:

• Use the device as described in this manual only.

• Despite of its robust design, protect the device from any unnecessary bumps and vibrations as well
as humidity and dirt.

• Do not touch or moisten the sensitive microphone membrane during work.

• Pay attention to the permissible temperatures for using the device.

• Always switch off the device after using.

• Do not expose the device to excess temperature as for example in a car with direct sunlight.

• If necessary, clean the device carefully without using solvents.

• Do not disassemble the device. Do not try to repair the device in case of malfuntion. Such manipulation
will always cause the loss of warranty and major damages. Make a note of the occuring errors and
send us the device for repair.

1.3 Power supply

Tango_Plus is powered by two batteries of the type LR6/AA (nominal voltage 1.2 . . . 1.5 V, primary cell
or rechargeable). So it can run for at least 40 hours. Via the according USB cable Tango_Plus can be
powered auxilliarily by an external source, but batteries must always be inserted. For that the cable has to be
connected to a PC or to the public power supply via a suitable adapter. The USB access is totally separated
from the internal batteries, so that the batteries are not affected, but accumulators are not recharged, too.

ATTENTION! For legally binding measurements Tango_Plus has to be powered by bat-
tery, disconnected from the public power supply.

1.3.1 Replace batteries

The battery compartment is located on the back at the bottom of the device (figure 1.1).

Figure 1.1: Open battery compartment

Follow the instructions below to replace the batteries:

• Move up the lock of the battery compartment.
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1.4 Design

• Remove the lid.

• Remove the discharged batteries.

• Insert the new batteries paying attention to the polarity (figure 1.1)

• Switch on the device and check the battery status on the display (figure 1.4.2).

ATTENTION! Changing the batteries causes loss of time, if Tango_Plus is not connected
to external power supply at the same time.

1.4 Design

Figure 1.2: Design of the device

Tango_Plus contains the following
parts: detachable microphone with
preamplifier, casing, display, keypad
and battery compartment. Opening
the device is only necessary for
replacing the batteries (figure 1.3.1).

At the bottom of the device the USB
socket is located for connecting
the device to a PC (type USB-C).
Next to it there is a socket for a 3.5
mm stereo jack. This monitoring
output is used to connect a headset
for example, it is not approved
for legally binding measurements.
Furthermore Tango_Plus provides a
socket to connect a printer directly
(section 2.5.5).

A detailed description of the display
and keypad is given in the para-
graphs 1.4.2 and 1.4.1. Pay also at-
tention to the notes given in para-
graph 1.2.

ATTENTION! For legally binding measurements Tango_Plus has to be powered only by
battery. The monitoring output is not approved for this.
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1 DESIGN

1.4.1 Keypad

If the device is not controlled via PC, you may also use the keypad for setup. In the middle it contains arrow
keys with an OK-button in the center. The top corners contain function keys, whose functions are indicated
by symbols on the display. The key below on the left is used to start and pause measurements, while the
one on the right switches on the device and toggles the brightness level.

1.4.2 Display

The display shows the measured values and is used for setting up the device. It is refreshed every 500 ms.
The status bar on the top of the display shows symbols for: Battery, Memory, Play/Pause, Storage, Calibra-
tion, USB connection, Level of brightness and time. Below the clock time the measuring time is displayed.
There are three basic modi to display spectra, history data or numeric values as well as a display for infor-
mation:

Figure 1.3: Third Octave Display

The Third Octave Display shows a
spectrum in the main part with live values
as bars and Leq values as roof top. Via
left/right keys the spectral cursor can be
moved to select signle bands. The band
level and the frequency are displayed
above the graph as well as the measu-
rement duration. On the left LAF and LCF

are displayed as bars. The bottom shows
numerically one sound level value, which
can be switched using the up/down keys.

Figure 1.4: History Display

Instead of a spectrum the History Display
shows two level graphs in the main part.
Which levels are shown is set in the confi-
guration (section 2.2.1). The time length of
the x-axis can be toggled with the left/right
keys.

Manual Tango_Plus 8 of 47 SINUS Messtechnik GmbH



1.5 First use

Figure 1.5: Numeric Display

The Numeric Display shows the value of
the levels selected at the bottom.

Figure 1.6: Info Measurement

The Info Display shows information on tabs
for:

• Measurement: Name, Date,
Duration, Time and File size

• Microphone: Calibration date, time
and status as well as sensitivity
and microphone connection mode
(section 3.1 and 3.2)

• Hardware: Firmware version, Har-
dware revision, serial numbers of
Preamplifier and Microphone cap-
sule (see also table 2.2 : Device >
Info)

NOTICE! A warning appears, if the original preamplifier is not detected. A Measu-
rement can still be performed, but an according remark is connected with
it.

1.5 First use

Pay attention to the following notes before using the device for the first time:

• Read carefully the manual and follow the instructions before using the device.

• Insert the batteries as described in section 1.3.1.

• Install the required software on a PC (driver and Tango-Utilities).

• Connect the device with the PC using the supplied USB cable.

• Switch on the device by pressing the On/Off-Button (minimum 3 seconds).
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1 DESIGN

1.6 Calculated values

Tango_Plus can calculate several sound levels as well as full and 1/3 octaves. Data can be stored up to an
amount of 32 MB.

1.6.1 Calculated sound levels

Level Description

LAF Sound pressure level, frequency weighting A, Fast (125 ms time constant)

LAFmax Level maximum of LAF for the entire measuring period (on the display) or of the last storing interval (stored data)

LAFmin Level minimum of LAF for the entire measuring period (on the display) or of the last storing interval (stored data);
only available by Tango-Utilities.

LAS Sound pressure level, frequency weighting A, Slow (1 s time constant)

LASmax Level maximum of LAS for the entire measuring period (on the display) or of the last storing interval (stored data)

LASmin Level minimum of LAS for the entire measuring period (on the display) or of the last storing interval (stored data);
only available by Tango-Utilities.

LCF Sound pressure level, frequency weighting C, Fast (125 ms time constant)

LCFmax Level maximum of LCF for the entire measuring period (on the display) or of the last storing interval (stored data)

LCFmin Level minimum of LCF for the entire measuring period (on the display) or of the last storing interval (stored data);
only available by Tango-Utilities.

LAImax Maximum sound impulse level, frequency weighting A

LCpeak Peak value of the C-weighted sound pressure level

LApeak Peak value of the A-weighted sound pressure level

LAeq Equivalent continuous sound pressure level for the entire measuring period (on the display) or of the last storing
interval (stored data), frequency weighting A

LCeq Equivalent continuous sound pressure level for the entire measuring period (on the display) or of the last storing
interval (stored data), frequency weighting C

LCeq - LAeq Difference of the values LCeq and LAeq

LAE Sound exposure level, frequency weighting A

LAFT Maximum LAF of the last 5 s interval.

LAFTeq Equivalent continuous sound pressure level calculated from the LAFT levels during the entire measuring period
according to DIN 45645-1

LAFTeq - LAeq Difference of the values LAFTeq and LAeq

LAIeq Equivalent continuous sound impulse level, frequency weighting A

LAIeq - LAeq Difference of the values LAIeq and LAeq

LCpeak>n Time in which the LCpeak exceeded n dB

LAFn Percentile levels can be calculated from the LAF (n = 1, 2, 3). There are 7 standard percentiles (1, 5, 10, 50, 90,
95, 99), but also user defined percentiles are possible.

Table 1.1: Calculated sound levels

NOTICE! All sound level values may only be reset by manual Start/Stop operation
and the integration time for the equivalent continuous sound pressure levels
may only be set with this operation.

NOTICE! All integrated sound levels listed in table 1.1 can be displayed on the device
immediately after finishing a measurement/integration.

1.6.2 Calculated spectra

Tango_Plus can calculate full and 1/3 octaves. A, C or Z weigthing may be applied. The frequency range is:
10 Hz - 20 kHz. The storage interval defines the number of individual spectra, that are linear averaged.
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1.7 Software installation

1.7 Software installation

First TANGO driver must be installed for that Tango_Plus is recognized via USB connection. Second Tango-
Utilities should be installed for configuration of Tango_Plus settings and export of data.

1.7.1 Tango_Plus driver installation

Please follow the instructions below to install the TANGO driver on a PC. You find the file on the enclosed
USB stick. Use the Windows Explorer to start the driver installation programme. Perform the install setting
and confirm always. Depending on the system performance this procedure may take a few minutes.

1.7.2 Tango-Utilities installation

Installing the software Tango-Utilities resembles the installation procedure of most Windows applications.
Follow the instructions below:

• Run the installation program (Tango_Utilities_Version.exe).

• The first window shows the software version. Click on Next to continue to the next window.

• Set the installation directory in the next window. Click on Next to continue to the next dialog.

• In this dialog you may specify the directory in the Windows Start Menu. Click on Next to continue to
the next dialog.

• This dialog summarizes your settings. Click on Install to confirm and continue.

• Finish the installation by clicking on Finish .

SINUS Messtechnik GmbH 11 of 47 Manual Tango_Plus



2 APPLIANCE

2 Appliance
2.1 Operating mode

Tango_Plus offers different operating modes:

OFF The device is off and no measurements can be performed. Only the clock is running inside.

Stop The device is running. The LAF and the LCF are measured and displayed. If Record mode is enabled,
the circle symbol is displayed.

NOTICE! The time between STOP and a possible new measurement is: 16 ms.

Run The device is on and measuring ( is blinking). If data recording has been activated, data will be
stored ( is blinking). You may read the instantaneous measurement values on the display and move
between the values using the Up/Down keys.

Pause A running measurement is paused ( is displayed) and so the measuring time. The measurement
can be stopped or proceeded any time.

Repeat If a duration is specified and repeat mode enabled, the so configured measuremet is repeated in
the specified interval.

Start Time A measurement is configured, but waiting with record for the specified time ( is blinking). The
device can be shut down. It will wake up automatically to perform the measurement and shut down
afterwards again. The measurement can be stopped any time.

Display Description

The device is in Pause-Mode. The measurement has been paused and the measuring time has been stopped.

Data recording is active. The measured data will be stored in Run-Mode.

The device is in Run-Mode (Symbol blinks). The measurement has been started. If data recording is active, the
measured data are stored. If data recording is inactive, no data will be stored.

A measurement is configured, but waiting with record for the specified time (symbol is blinking). When the measure-
ment is running, the symbol stops blinking.

Table 2.1: Display of run modes

NOTICE! The setting for automatic start time can only be configured manually on the
device.

2.2 Device configuration

You may configure the device manually or via PC using the software Tango-Utilities.

2.2.1 Manual configuration

The manual configuration of the device without PC is shown in the following table 2.2:
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2.2 Device configuration

Item Description

Measurement

Record Mode Select values to be stored or just displayed.

Sync at Full Hour Synchronize time intervals to full hours.

Fixed Duration Measurement ends after a fixed time.

Repeat Mode If a Fixed Duration is specified an automatic repeat can be enabled.

Repeat Interval If a Fixed Duration is specified and the Repeat Mode is enabled, an interval must be configured
in which the measurement is repeated. So can be configured for example to measure every day
for 1 hour at 6 o’clock.

Start Time Predefine a time to start the measurement automatically.

Calibration

Start Calibration Start the process of calibration.

Calibration Level Set the calibration level (94.0 dB, 104.0 dB, 114.0 dB, Other).

Reset Calibration Reset the calibration level to factory value.

Measurement Values (Select a sound level e.g. LAFmax and adjust the following properties.)

Display Location Select on which graph the value shall be shown.

Display Interval Select the rate of display refresh (500 ms, . . . , 60 min, End Result only).

Storage Interval Set the storage interval (No storage, 62.5 ms, . . . , 60 min, End Result only).

Print Result Decide whether the result shall be printed.

Octave Spectrum

Octave Mode Select whether 1/3 or full octaves shall be measured.

Display Range Adjust the scaling of the Y-axis.

Display Weigthing Available weigthings: Z, A, C

Display Interval Select the rate of display refresh (125 ms, . . . , 60 min, End Result only).

Storage Weigthing Available weigthings: Z, A, C

Storage Interval Set the storage interval (No storage, 125 ms, . . . , 60 min, End Result only).

History Graph

Display Range Adjust the scaling of the Y-axis.

History Time Adjust the scaling of the X-axis.

Graph 1 Select which value shall be displayed as yellow.

Graph 2 Select which value shall be displayed as green.

Storage Files

Stored Files View Results, Delete File

Reset Storage File ID Resets File ID to the smallest possible number, so that no gaps are filled with new measurements:
Assume stored measurements are labled with IDs 1 to 6. If for example measurements 3, 5, and
6 are deleted and the File ID is reset, the next measurement will be labled with the number 5.

Erase all Storage Files Clear all Files.

Device

Time Set time and select 12h or 24h format.

Display Set Display properties.

Panels Set, whether Panels should be displayed or not:
Octave Spectrum, History Graph, Results, Measurement Info

Options Additional configurational settings:
Microphone Connection (Direct connection, cable connection, Weather Protector)
Power (automatic: On by USB, On by Reset, Off by Inactivity)

Info Provides information about firmware and hardware (see also figure 1.6).

Reset Configuration Reset to factory settings.

Print Results

Table 2.2: Manual configuration menu of Tango_Plus
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2 APPLIANCE

2.3 Tango-Utilities

Tango-Utilities is the basic software to configure Tango_Plus and export values from measurements. It is
not meant to perform further analysis calculations. For configuring the device via PC, you have to install the
Tango-Driver and Tango-Utilities software first (section 1.7). Tango-Utilities contains a line for main menu
and a line with buttons for: Stop, Run/Pause, Store/Not Store, Set Marker and start calibration. At the bottom
the Tabs are located and the status bar.

Figure 2.1: Tango-Utilities view: Main menu, buttons, working area, Tabs, Status bar

2.3.1 Status bar

The status bar displays various status information from left to right:
Connection Status: disconnected, connected, but Tango_Plus off, connected, Tango_Plus on;
Virtual COM Port;
Measurement Status: Stop, Measurement, Pause;

Record Status: Record-Mode off, Record-Mode on,
blinken←→ Record-Mode on (Recording);

Marker Status: MARK;
Memory usage: per Hour, Day and Week

2.3.2 Program settings and Extended device settings

Via the main menu Settings->Program. . . the following settings are available (figure 2.2): Selection of the
connected device Tango_Plus (Connected Device), default export directory (Default Export Directory)
and the default directory for configuration data. The Extended device settings cannot be adjusted manually
without PC.

Figure 2.2: Tango-Utilities - Program settings Figure 2.3: Tango-Utilities- Extended device settings
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2.3 Tango-Utilities

Parameter Description

Disable Device Calibration Select this parameter to disable calibration feature on the device.

Disable display setup changes Select this parameter to lock the display settings.

Disable measurement setup changes Select this parameter to lock measurement recording settings.

Enable fixed record mode Select this parameter to activate the Record-Mode permanently.

Startup after battery replacement Automatic start of Tango_Plus after changing the batteries.

Table 2.3: Extended progam settings

2.3.3 Info Tab

You may view the software version of Tango-Utilities in the main menu selecting Help -> About (figure 2.5).
The firmware version of the device is displayed in the Info-Tab (figure 2.4).

Figure 2.4: Tango-Utilities - Info Tab Figure 2.5: Tango-Utilities - About-Box

2.3.4 Setup Tab

The Setup tab of Tango-Utilities (figure 2.6) provides the configuration of Tango_Plus for a measurement.
In the column Display use the check boxes to enable individual values and comboboxes to set the graphic
refresh rate for display. Several values offer optional parameters, which you may set in the column Options.
By the buttons Open and Save you may open a configuration from the PC or save the current one to it. The
same can be done by using the menu points File→ "‘Open Configuration"’ and File→ "‘Save Configu-
ration As"’. The current configuration is transmitted to Tango_Plus by clicking on Apply .

In the column Storage the correspondig storage conditions are adjusted. The storage can be turned off,
limited to one finish result or done in regular intervals. For the interval time span several values are provided
from 62,5 ms up to 60 min depending on the measurement value. Even if the interval storage is selected a
finish result over the whole measurement time is calculated and stored additionally. This would always be
saved, even if the intervall storage would have been aborted because of full memory. In this case the record
symbol would stop blinking.

NOTICE! For the interval storage of the percentiles only the same interval time span
can be selected.

If Synchronisation is enabled, the interval storage will be synchronised with the full hours of day time. So
every full hour the current interval is closed and a new one is started. The clock is set every time, when
connecting Tango_Plus to Tango-Utilities.
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2 APPLIANCE

Figure 2.6: Configuration in setup tab
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2.3 Tango-Utilities

2.3.5 Display Tab

In the Display tab history values are shown (figure 2.7), which are calculated by the device during a measu-
rement (according to the settings in the Setup-Tab). On the left side you will find a table of values which can
be displayed. You may select a maximum of four values for simultaneous display. The context menu of the
graph provides Zoom and axes scaling functionality.

Figure 2.7: Show history values in Display Tab

2.3.6 Octave Tab

Figure 2.8: Show spectral values in Octave Tab

In the “1/3 Octave” tab spectral values are shown (figure 2.8), which are calculated by the device during a
measurement (according to the settings in the Setup-Tab). To adjust weigthing (Z-blue, A-green, C-yellow)
or refresh rate for graphical display click on the corresponding items in the header of the graph. The context
menu of the graph provides scaling functionality. Also displayed is a coordinate cross. The vertical line
shows the current value of the selected band while the horizontal line shows the sum value.
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2 APPLIANCE

2.3.7 Data-Tab

On the right side of the Data-Tab (figure 2.9) a table containing the recorded files is displayed. On the left
side a summary of the selected measurement is displayed. By right-clicking on an entry in the table you will
open a context menu in which you may delete the measurement (Delete) or export data (Export).

Figure 2.9: Data Tab

ATTENTION! Maximum 128 files can be stored!

Manual Tango_Plus 18 of 47 SINUS Messtechnik GmbH



2.3 Tango-Utilities

2.3.8 Data export

Measured data are saved to the internal storage of the device (32 MB). The data sets are listed in the
Data-Tab (section 2.3.7). By right-clicking you may open a context menu, that provides access to the Export
window (figure 2.10).

History Data tab

This tab provides the export of time histories of level or spectra to the Excel compatible csv format. To use
it, check the “Enable Export file” box. You may specify the name, check automatic attributes to be given to
the export file name and select the values, which that file should contain. Via the Add File button, you can
create more History Data tabs, to get several different configured export files from the same measurement
in the same export process.

Figure 2.10: Export - History Data

NOTICE! If the set intervals do not fit exactly into the hourly grid for a synchronized
measurement, the data of the last interval will be marked accordingly.

Result List tab

Enable this way of export to collect Endresults of all exported measurements in csv format. The configuration
is similar to the History Data tab.
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Figure 2.11: Export - Result List

Result tab

This tab provides the export only of end results as txt or csv. Just type the filename with the desired format.

Figure 2.12: Export - Result
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2.4 Calibrate

Auditor tab

This tab provides the export of full data as Auditor readable smr format.

Figure 2.13: Export - Auditor

Additional Information tab

This tab allows to put additional information showing up in all export files. Especially a measurement time
can be applied manually using the Set Time button.

Figure 2.14: Export - Additional Information

2.4 Calibrate

A list of the approved calibrators and the accuracy classes achieved is given in section 4.2. Follow the
instructions below to calibrate the device at 1 kHz.

2.4.1 Calibrate using Tango-Utilities

1. Connect Tango_Plus to the PC.

2. Start Tango-Utilities.

3. Insert the microphone into the calibrator and activate the calibration signal. The reference calibration
level is 94 dB for this methode.

4. Press the CAL button in Tango-Utilities. “Calibration activated” appears in the status bar. To cancel
the calibration procedure, press the stop button.
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5. Having finished you are asked to adopt the new calibration values. If something went wrong, an error
message appears.

2.4.2 Calibrate Tango_Plus directly

1. Switch on the device.

2. Press the Setup-Button and navigate to the calibration menu.

3. Adjust the calibration level and execute “Start Calibration”. The reference calibration level will be
blinking on the display (e.g. 94 dB). You may adjust this value with the Scroll-Button (94 dB, 104 dB
or 114 dB).

4. Switch on the calibrator (select the correspondig level on the calibrator, if necessary) and insert the
microphone into the calibrator.

5. Press the OK-Button and Calibration starts. First, the noise level of the device is measured and second
the calibrator signal. During calibration, is blinking on the display. When stops blinking, the
calibration is finished. The measured level is displayed enabling you to check the calibration result.

6. Press the OK-Button to save the new sensitivity value or press the Setup-Button to reject.

7. You have left the calibration menu and the device is in STOP-Mode.

If the calibration has been affirmed the symbol is shown on the display until the next start of Tango_Plus.

NOTICE! If the new value deviates more than 3 dB from the last one, it is not accep-
ted. The message “Error” is displayed in this case. This tolerance is redu-
ced to ± 1.5 dB for approvable devices.

Figure 2.15: Calibration menu

NOTICE! On the device you can reset the calibration result to factory value via:
“Menu > Calibration > Reset Calibration”.
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2.5 Measure

2.5 Measure

For legally binding measurements the device must run on batteries/rechargeables. Therefore the device
has to be controlled with the keypad (section 1.4.1). Follow the instructions below to perform a binding
measurement:

1. Position the device (held in the hand or mounted upon a tripod).

2. Switch on the device.

3. Check the battery charge status.

4. Use the Record-Button to enable/disable data recording.

5. Press the Start-Button to start the measurement.

6. Press the Stop-Button to stop the measurement.

2.5.1 Measure low sound levels

You do not have to make special preparations for measuring low level sounds.

2.5.2 Overload and Underrange

The indicator for overload and underrange is located on the right or left respectively of the bar graph on the
display. They are displayed, when the linearity range is left.

NOTICE! A reset of the overload or underrange display is only possible by stopping
and restarting the measurement.

The representation on the display is explained in the following table 2.4.

Tango-Utilities Display Description

No overload has occured in current measurement.

Overload has occured in current measurement.

Currently an overload occurs.

No underrange has occured in current measurement.

Underrange has occured in current measurement.

Currently an underrange occurs.

Table 2.4: Display of overload and underrange

2.5.3 Calibrated Measurement

The calibration control procedure ensures that it is clear for the measurements taken, whether the instrument
is in the calibrated state or not. For Tango_Plus a measurement is considered as calibrated, if the device
has been successfully calibrated between switch on (deletes the calibration status) and the start of the
measurement. The following information is collected:

• Date and time of calibration

• Sensitivity

• Deviation from previous calibration (checked during calibration but not saved)
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• Deviation from original factory calibration (checked during calibration but not saved)

Loss of calibration status is effected by:

• Switching off the device (except when the measurement start is scheduled with a preset start time)

• Switch off the device during measurement breaks in repeat mode

• Cancel of calibration

2.5.4 View measurement results on Tango_Plus

It is possible to view the measurement results on the device via: “Menu > Stored Files > [File] > View
Results”. There you find resulting level and resulting 1/3 octaves as well as information about calibration
status, microphone sensitivity and whether the microphone was dircetly connected or detached.

2.5.5 Print results

If a printer is connected, you may set results to be printed after the measurement (section 2.2.1) under:
Functions > Measurement Values > [Value] > Print Result. This is possible for all sound levels that result in
one number like for example LAeq or LCFmax. You are asked to print after each measurement automatically.
You may also recall a measurement and print the result via: Functions > Print Results.
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3 Information for type approval
Tango_Plus can be used in different configurations, first as a classic handheld level meter with direct inci-
dence and second as part of the Outdoor Kit with sound incidence from the sides. All configurations are
designed according to IEC 61672-1:2014, accuracy class 1 and immunity to interference group Z and accor-
ding to IEC 61260:2003 for 1/1 and 1/3 octaves. Additionally there is a configuration under electric test for
type approval.

NOTICE! The configuration is set on the device under:
Menu > Device > Options > Microphone Connection.

Using Tango_Plus the following sound level values may be measured: LAF, LAFmax, LAFmin, LCF, LCFmax, LCFmin,
LAImax, LAS, LASmax, LASmin, LCpeak, LAeq, LCeq, LCeq-LAeq, LAE, LAFT, LAFTeq, LAFTeq-LAeq, LAIeq, LAIeq-LAeq, LCpeak>n and LAFn. A
detailed description of these values is given in table 1.1 in section 1.6.

In addition, linear averaged 1/3 octaves and full octaves can be measured with frequency weightings A, C
and Z.

NOTICE! The number of the firmware version can be displayed (section 2.2.1).

3.1 Configuration as classical handheld level meter

As classical handheld level meter Tango_Plus is used with attached or detached microphone (via Micro-
extension cable) and windscreen W2. Under “Settings > Device > Options > Microphone Connection” select
"‘Direct Connection"’ or "‘Cable Connection"’ accordingly. For both configurations the frequency response
is nearly equal and within the tolerance. The direction of sound incidence is 0◦referring to the microphone
axis. The following parts are permitted for the use of Tango_Plus under mandatory verification according to
type approval :

• Tango_Plus (907004.2)

• Micro extension cable 3m (907308)

• Calibrator Cal200 1/2” type1 PCB (800934.4)

• Calibrator Type 4231 (B&K) (800043.2)

• Windscreen W2 (800253.0)

The Windscreen W2 is black coloured and spherically with a diameter of 69 mm.

3.1.1 Frequency response of Tango_Plus - Configuration SLM
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3 INFORMATION FOR TYPE APPROVAL

mid frequency cut-off frequency Correction value

in Hz in Hz in dB

50 44,7 0,00

63 56,2 0,00

80 70,8 0,00

100 89,1 0,00

125 112 0,00

160 141 0,00

200 178 0,00

250 224 0,00

315 282 0,00

400 355 0,00

500 447 0,00

630 562 0,00

800 708 0,00

1000 891 0,00

mid frequency cut-off frequency Correction value

in Hz in Hz in dB

1250 1122 -0,05

1600 1413 -0,10

2000 1778 -0,20

2500 2239 -0,20

3150 2818 0,40

4000 3548 0,10

5000 4467 0,60

6300 5623 0,80

8000 7079 0,90

10000 8913 0,95

12500 11220 1,00

16000 14130 1,40

20000 17780 2,00

- - -

Table 3.1: Correction to the frequency raw data for the Configuration SLM.

3.1.2 Directional characteristics - Configuration SLM
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3.1 Configuration as classical handheld level meter
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Figure 3.1: Mikrophone axis

3.1.3 Corrections according to case reflections - Configuration SLM with connected mi-
crophone

The corrections are valid for the whole Tango_Plus station, so including windscreen W2, with attached
microphone. With detached microphone there is no effect.

NOTICE! Corrected values are calculated by adding the corrections to the measured
pure values.
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mid frequency cut-off frequency Case refl. corr.
in Hz in Hz in dB

63 56,2 0,1

80 70,8 -0,38

100 89,1 -0,3

125 112 -0,2

160 141 -0,24

200 178 -0,19

250 224 -0,02

315 282 -0,14

400 355 -0,03

500 477 -0,04

630 562 -0,12

800 708 0,01

1000 891 -0,15

Table 3.2: Case reflection corrections in 1/3 octaces
(manufacturer’s specification: measurement uncertainty at 95% certainty ±0 dB)

mid frequency cut-off frequency Case refl. corr.

in Hz in Hz in dB

1030 1.000,0 -0,31

1090 1.059,3 0,03

1150 1.122,0 0,04

1220 1.188,5 -0,06

1300 1.258,9 0,09

1370 1.333,5 -0,01

1450 1.412,5 0,24

1540 1.496,2 0,08

1630 1.584,9 -0,38

1730 1.678,8 -0,13

1830 1.778,3 0,22

1940 1.883,6 0,14

2050 1.995,3 0,3

2180 2.113,5 -0,09

2300 2.238,7 -0,37

2440 2.371,4 -0,05

2590 2.511,9 -0,14

2740 2.660,7 -0,23

2900 2.818,4 -0,41

3070 2.985,4 0

3250 3.162,3 0,44

3450 3.349,7 0,11

3650 3.548,1 0,56

3870 3.758,4 0,33

4100 3.981,1 -0,82

mid frequency cut-off frequency Case refl. corr.

in Hz in Hz in dB

4340 4.217,0 -0,29

4600 4.466,8 -0,51

4870 4.731,5 0,21

5200 5.011,9 0,47

5500 5.308,8 -0,01

5800 5.623,4 -0,2

6100 5.956,6 -0,31

6500 6.309,6 0,24

6900 6.683,4 0,24

7300 7.079,5 -0,29

7700 7.498,9 -0,06

8200 7.943,3 0,28

8700 8.414,0 -0,03

9200 8.912,5 -0,17

9700 9.440,6 0,12

10300 10.000,0 -0,12

10900 10.592,5 -0,16

11500 11.220,2 -0,02

12200 11.885,0 -0,07

13000 12.589,3 0,05

13700 13.335,2 -0,05

14500 14.125,4 0

15400 14.962,4 -0,18

16300 15.848,9 0,04

- - -

Table 3.3: Case reflection corrections in 1/12 octaces
(manufacturer’s specification: measurement uncertainty at 95% certainty ±0 dB)
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3.2 Configuration with weather protection - Outdoor Kit

3.2 Configuration with weather protection - Outdoor Kit

With the optional Outdoor Kit Tango_Plus can be used as temporary monitoring station for environmental
noise. Under "‘Settings > Device > Options > Microphone Connection"’ "‘Weather Protector"’ must be se-
lected. The runtime from the external battery depends on the measurement configuration, a typical value
is 2 month. The data are stored locally. The direction of sound incidence is 90◦referring to the microphone
axis.

Figure 3.2: Tango “Outdoor Kit”

The following items are included in the outdoor kit (figure 3.2):

• Peli Case 1500 with foam insert and LEMO7 Cable intern (907305.3)

• V-Mount Li-Akku 14.8V/6.1A (801232.3)

• FD-BT16V Li-Ion Charger (801352.5)

• Tango DC/DC-Adapter (907240.X)

• Microphone cable Tango_Plus, 3m (907308)

• Microphone cable Tango_Plus, 0.4m (907309)

• TA202L dry adapter Tango (801419.8)

• Weather Protector SWS1 (907315.8)

• Tripod (800630.0)

3.2.1 Weather Protector SWS1

First disconnect the microphone from Tango_Plus and carefully unscrew the Microphone Capsule (A) from
the Microphone Preamplifier (B) (figure 3.3). Be careful not to release the protective grille from the capsule,
but to unscrew the entire capsule unit.
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Figure 3.3: Preamplifier and capsule

Next, insert the TA 202L (C) dry adapter between the components that are currently separated (figure 3.4).
Check whether the black sealing ring of the dry adapter is still correctly located on the thread root.

NOTICE! Without the dry adapter Tango_Plus must not be operated with the weather
protection!

Figure 3.4: TA202L mounting between preamplifier and capsule

Next, prepare the weather protection for the assembly. First remove the Windscreen (D) (figure 3.5).

Figure 3.5: Weather protector and windscreen

Then unscrew the Protective Sleeve (E) from the Shaft (G) and loosen the Shank Head (F) slightly. Be
sure to use strength only on the stainless steel components and not damage the fee. Then turn off the
socket (H) (figure 3.6).

Figure 3.6: Disassembling of the Weather protector SWS1

Pass the Tango_Plus microphone cable (I) through the shaft, so that the socket end can be connected
to the composite microphone unit on the preamplifier. At the end of the shaft, guide the cable through the
recess before screwing the socket (H) back in (figure 3.7).
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3.2 Configuration with weather protection - Outdoor Kit

Figure 3.7: Mounting the cable

Then carefully slide the microphone unit into the protective sleeve (E) until the head of the microphone
capsule is at the end of the sleeve. Now you can screw the sleeve back onto the shaft (G). Keep the
weather protection at a slight angle, so that the head surface of the microphone remains at the end of the
sleeve and does not slip. Tighten the previously loosened shaft head (F) to fix the microphone. The weather
protection can now be set up vertically without the microphone lowering. Finally the Windscreen (D) can be
put on again. Make sure that the lower end of the windscreen is flush with the shaft head (F) (figure 3.8).

NOTICE! The correct positions of microphone and windscreen must always be gua-
ranteed. Otherwise there will be falsifications of the later measurements.

Figure 3.8: Mounting the windscreen

NOTICE! For later calibrations, it is sufficient to remove the windscreen (D) and the
protective sleeve (E). Make sure that the microphone is in the correct posi-
tion vertically.

The transparent picture of the final compositions (figure 3.9) shows, that the microphone is closed to the
weather protection inside.

907144.5
TA 202L

Figure 3.9: Transparent picture of the inner composition
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3.2.2 Frequency response of the microphone - Configuration Outdoor Kit

10 100 1k 10k

−4

−2

0

2

f / Hz

A
m

pl
itu

de
/d

B

TangoPlus Outdoor Kit Tolerance

If the configuration with weather protector is selected in the device, the following values are added internally
to result in the frequency response shown above.

mid frequency cut-off frequency Correction value

in Hz in Hz in dB

50 44,7 0,00

63 56,2 0,00

80 70,8 0,00

100 89,1 0,00

125 112 0,00

160 141 0,00

200 178 0,00

250 224 0,00

315 282 0,00

400 355 0,00

500 447 0,00

630 562 0,00

800 708 0,00

1000 891 0,00

mid frequency cut-off frequency Correction value

in Hz in Hz in dB

1250 1122 0,30

1600 1413 0,30

2000 1778 0,30

2500 2239 0,4

3150 2818 0,9

4000 3548 1,0

5000 4467 2,2

6300 5623 3,5

8000 7079 4,0

10000 8913 4,0

12500 11220 4,0

16000 14130 4,0

20000 17780 4,0

- - -

Table 3.4: Correction to the frequency raw data for the Configuration Outdoor Kit.
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3.2 Configuration with weather protection - Outdoor Kit

3.2.3 Directional characteristics - Configuration Outdoor Kit
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3.2 Configuration with weather protection - Outdoor Kit
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3.2.4 Corrections for the use of the weather protector

The corrections are valid for the whole Tango_Plus station, so including weather protection SWS1. Corrected
values are calculated by adding the corrections to the measured pure values.

mid frequency cut-off frequency Case refl. corr.

in Hz in Hz in dB

63 56,2 -0,43

80 70,8 -0,13

100 89,1 0,26

125 112 -0,1

160 141 -0,1

200 178 0,04

250 224 0,01

mid frequency cut-off frequency Case refl. corr.

in Hz in Hz in dB

315 282 0,15

400 355 0,13

500 447 0,1

630 562 0,3

800 708 0,02

1000 891 0,19

- - -

Table 3.5: Case reflection corrections in 1/3 octaces
(manufacturer’s specification: measurement uncertainty at 95% certainty ±0 dB)

mid frequency cut-off frequency Case refl. corr.

in Hz in Hz in dB

1030 1.000,0 -0,02

1090 1.059,3 0,34

1150 1.122,0 0,26

1220 1.188,5 0,14

1300 1.258,9 -0,06

1370 1.333,5 0,29

1450 1.412,5 0,21

1540 1.496,2 0,13

1630 1.584,9 0,23

1730 1.678,8 0,1

1830 1.778,3 -0,01

1940 1.883,6 0,33

2050 1.995,3 0,12

2180 2.113,5 0,06

2300 2.238,7 -0,09

2440 2.371,4 -0,19

2590 2.511,9 -0,05

2740 2.660,7 0,19

2900 2.818,4 0,04

3070 2.985,4 -0,08

3250 3.162,3 -0,54

3450 3.349,7 -0,5

3650 3.548,1 0,18

3870 3.758,4 0,54

4100 3.981,1 0,12

mid frequency cut-off frequency Case refl. corr.

in Hz in Hz in dB

4340 4.217,0 -0,67

4600 4.466,8 -0,49

4870 4.731,5 0

5200 5.011,9 -0,79

5500 5.308,8 -1,45

5800 5.623,4 -0,56

6100 5.956,6 -0,31

6500 6.309,6 -0,98

6900 6.683,4 0,06

7300 7.079,5 -0,69

7700 7.498,9 -0,65

8200 7.943,3 -0,84

8700 8.414,0 -0,77

9200 8.912,5 -0,52

9700 9.440,6 0,59

10300 10.000,0 0,63

10900 10.592,5 -0,01

11500 11.220,2 -0,03

12200 11.885,0 1,16

13000 12.589,3 2,11

13700 13.335,2 1,98

14500 14.125,4 1,4

15400 14.962,4 1,92

16300 15.848,9 1,32

- - -

Table 3.6: Case reflection corrections in 1/12 octaces
(manufacturer’s specification: measurement uncertainty at 95% certainty ±0 dB)
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3.3 Configuration for electrical test

3.3 Configuration for electrical test

For eletrical testing use the equivalent electrical impedance device K65 (figure 3.10) only. Table 3.7 descri-
bes its properties.

Figure 3.10: Image of K65

Feature Value

Model Transducer type Equivalent electrical impedance for 1/2”

Mikrophone preamplifyer

Capacitance CE 22 pF

Temperature range +20 . . . +60 ◦C

Diameter 17 mm

Length 60 mm

Weight 46 g

Table 3.7: Technical data of K65 (800030.3)

This configuration is dedicated to type approval test only. “Direct connection” must be selected under “Functi-
ons > Device > Options > Microphone Connection”.

3.3.1 Frequency response of the microphone - Configuration for electrical test
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TangoPlus Frequency Generator Tolerance

mid frequency cut-off frequency Correction value

in Hz in Hz in dB

50 44,7 0,00

63 56,2 0,00

80 70,8 0,00

100 89,1 0,00

125 112 0,00

160 141 0,00

200 178 0,00

250 224 0,00

315 282 0,00

400 355 0,00

500 447 0,00

630 562 0,00

800 708 0,00

1000 891 0,00

mid frequency cut-off frequency Correction value

in Hz in Hz in dB

1250 1122 0,00

1600 1413 0,00

2000 1778 0,00

2500 2239 0,00

3150 2818 0,00

4000 3548 0,00

5000 4467 0,00

6300 5623 0,00

8000 7079 0,00

10000 8913 0,00

12500 11220 0,00

16000 14130 0,00

20000 17780 0,00

- - -

Table 3.8: Correction to the frequency raw data for the Configuration Electrical test.
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3 INFORMATION FOR TYPE APPROVAL

3.3.2 Details on EMC

When the device is exposed to electromagnetic emissions the lower limits of the ranges in table 3.11 are
increased by 5 dB. Within these changed ranges the error limits according to IEC 61672-1:2014 are main-
tained. The level linearity range changes to 40. . . 107 dB(A) when the device is exposed to electromagnetic
emissions. There will be no performance loss in the device after electrostatic discharges (touch discharge
up tp 4 kV and air discharge up to 8 kV).

ATTENTION! Legally binding measurements must not be performed, if the device is con-
nected to public power supply.

3.3.3 EMC test

The measurement is performed for the following configurations:

Low interference immunity: USB cable linked to public power supply and microphone extension cable
connected

Maximim interference immunity: USB cable and microphone extension cable disconnected

3.3.4 Mains frequency and high-frequency fields

Tango_Plus complies with IEC 61672-1:2014 with respect to interference immunity to mains frequency and
high-frequency fields. The interference immunity to mains frequency and high-frequency fields is highest
when the device is running on batteries/rechargeables without USB cable connected.

Figure 3.11: Alignment measurement HF immunity

If Tango_Plus is connected to a PC and measuring high-frequency emissions are highest. Additionally, the
interference immunity to mains frequency and high-frequency fields is lowest in this configuration (alignment
see fig. 3.11). The next lowest emission level is reached in the same configuration, but in STOP-Mode.
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3.4 Effect of environmental conditions

In compliance with paragraph 6.6.9 of IEC 61672-1:2014 Tango_Plus is not appropriate to measure levels
lower than 74 dB for an electric field strength exceeding 10 V/m.

3.4 Effect of environmental conditions

In order to avoid the effect of sound reflections from the body of the operator interfering with the measure-
ment, Tango_Plus should be located as far as possible from the body. Thus, when actually performing the
measurement, the operator should place himself at a distance behind the tripod-mounted meter, or extend
the hand-held meter as far from the body as is comfortable.

NOTICE! When the temperature changes by more than 15 ◦C an acclimatization time
of 30 min must be safeguarded.

Within the limits of the linear operating ranges, the measurement of low sound levels is possible without
restrictions. Then a sufficient signal-to-noise ratio is guaranteed.

NOTICE! If there is a significant change in the static air pressure, an acclimatization
time of 1 min must be observed to ensure pressure equalization through
the holes provided.

3.4.1 Effect of mechanical vibration

To measure the influence of mechanical vibrations you need a second sound level meter with officially verified
calibration as reference device. The microphone of the reference device has to be positioned in a maximum
distance of 0.2 m from the microphone of the tested device and must not be exposed to the mechanical
vibrations of the exciter.

Figure 3.12: Alignment for vibration test

SINUS Messtechnik GmbH 39 of 47 Manual Tango_Plus



3 INFORMATION FOR TYPE APPROVAL

If the device is exposed to mechanical vibration with an acceleration of 1 m/s2 perpendicular to the mem-
brane plane of the microphone, the lower limit of the linear operating range increases to 75 dB for the
frequencies 31,5 Hz, 63 Hz, 125 Hz, 250 Hz, 500 Hz, 630 Hz, 800 Hz and 1000 Hz, frequency weighting A.

If the device is exposed to mechanical vibration with an acceleration of 1 m/s2 parallel to the membrane
plane of the microphone, the lower limit of the linear operating range increases to 58 dB for the frequencies
31,5 Hz, 63 Hz, 125 Hz, 250 Hz, 500 Hz, 630 Hz, 800 Hz and 1000 Hz, frequency weighting A.

3.5 Self-generated noise

In a sound field with an insignificant contribution to the inherent noise, levels of LAF < 14 dB as well as
LCF < 16 dB are to be expected.
The electrical noise inherent in the preamplifier (terminated with spare capacity and 50Ω at the input) will
produce LAFmax < 14 dB as well as LCFmax < 20 dB in the display device.

3.6 Linear operating ranges

The operating ranges given below are only valid for calibrated devices! The starting value for each level
linearity test is 94 dB at 1 kHz.

Frequency max in dB(A) min in dB(A) Range in dB(A)

31,5 Hz 100 25 75

1 kHz 140 25 115

4 kHz 140 27 113

8 kHz 139 27 112

12,5 kHz 135 27 108

Table 3.9: Linear operating ranges A-weighted

Frequency max in dB(C) min in dB(C) Range in dB(C)

31,5 Hz 137 62 75

1 kHz 140 30 110

4 kHz 138 30 108

8 kHz 137 30 107

12,5 kHz 133 30 103

Table 3.10: Linear operating ranges C-weighted

3.6.1 Level linearity range

The following table 3.11 contains the measurement ranges for A-weighted sound levels and the C-weighted
peak sound level for microphone sensitivity of 50 mV/Pa.

Fast/Slow/Leq in dB(A) LAE in dB(A) LCpeak in dB(C)

25. . . 140 ab 25 37. . . 143

Table 3.11: Level linearity ranges for A-weighted sound levels and C peak
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3.7 Frequency weighting

3.7 Frequency weighting

f A Tango C Tango A Standard C Standard Diff A Diff C

10 -67,93 -13,76 -70,00 -14,30 2,07 0,54

12,5 -62,56 -10,84 -63,40 -11,20 0,84 0,36

16 -55,90 -8,12 -56,70 -8,50 0,80 0,38

20 -50,00 -5,94 -50,50 -6,20 0,50 0,26

25 -44,54 -4,20 -44,70 -4,40 0,16 0,20

31,5 -39,36 -2,90 -39,40 -3,00 0,04 0,10

40 -34,36 -1,88 -34,60 -2,00 0,24 0,12

50 -30,14 -1,22 -30,20 -1,30 0,06 0,08

63 -26,12 -0,78 -26,20 -0,80 0,08 0,02

80 -22,32 -0,46 -22,50 -0,50 0,18 0,04

100 -19,06 -0,28 -19,10 -0,30 0,04 0,02

125 -16,12 -0,18 -16,10 -0,20 -0,02 0,02

160 -13,22 -0,10 -13,40 -0,10 0,18 0,00

200 -10,82 -0,06 -10,90 0,00 0,08 -0,06

250 -8,66 -0,04 -8,60 0,00 -0,06 -0,04

315 -6,62 0,00 -6,60 0,00 -0,02 0,00

400 -4,74 0,00 -4,80 0,00 0,06 0,00

f A Tango C Tango A Standard C Standard Diff A Diff C

500 -3,22 0,00 -3,20 0,00 -0,02 0,00

630 -1,92 0,00 -1,90 0,00 -0,02 0,00

800 -0,78 0,00 -0,80 0,00 0,02 0,00

1000 0,00 0,00 0,00 0,00 0,00 0,00

1250 0,58 -0,06 0,60 0,00 -0,02 -0,06

1600 0,98 -0,06 1,00 -0,10 -0,02 0,04

2000 1,20 -0,18 1,20 -0,20 0,00 0,02

2500 1,28 -0,28 1,30 -0,30 -0,02 0,02

3150 1,26 -0,40 1,20 -0,50 0,06 0,10

4000 1,10 -0,68 1,00 -0,80 0,10 0,12

5000 0,78 -1,06 0,50 -1,30 0,28 0,24

6300 0,20 -1,64 -0,10 -2,00 0,30 0,36

8000 -0,60 -2,46 -1,10 -3,00 0,50 0,54

10000 -1,74 -3,62 -2,50 -4,40 0,76 0,78

12500 -3,30 -5,14 -4,30 -6,20 1,00 1,06

16000 -5,48 -7,32 -6,60 -8,50 1,12 1,18

20000 -7,90 -9,74 -9,30 -11,20 1,40 1,46

Table 3.12: A- and C-weighted frequency response

3.8 Verifiable Firmware

Tango_Plus is verifiable with the firmware version 2.51. The version can be checked via: Functions > Device
> Info.

Figure 3.13: Display of verifiable firmware version with lock symbol

NOTICE! If the firmware is verified, it will be indexed in the display with a lock symbol.
An update by subsequent versions is not possible!
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4 TECHNICAL SPECIFICATIONS

4 Technical specifications

Property Value

Software Tango-Utilities

Number of channels 1

Accuracy Class 1 according to IEC 61672-1:2014

Display of measured values Colour TFT 320 x 240

Display refresh rate 500 ms

Frequency weighting A, C (simultaneously), no optional frequency weightings

Time weighting Fast, Slow, Peak (simultaneously), Impulse

Data storage Yes

Self-generated noise ≤14 dB(A), ≤16 dB(C)

Max. Sound Pressure Level see table 4.3

Linearity range 25. . . 140 dB(A) (at 1 kHz)

Nominal measuring range for LCpeak 37. . . 143 dB(C)

Max. electr. measuring range ± 2 V

Max. input voltage at
the input of the feeding device

± 2,5 V

Umax at input ± 2,5 V

Integration response immediate

Time weighting F Rise or decay time constant = 0.125 s

Time weighting S Rise or decay time constant = 1 s

Time weighting Peak Rise time constant = 20 µs

Time weighting Impulse Rise time constant = 0.035 s, decay time constant = 1.5 s

Shortest integration time 16 ms

Longest integration time 194 days (100 h running on rechargeables)

Interfaces USB-C, serial printer port, 3.5mm stereo jack

Stabilizing time after switch-on 1 min

Warm-up time 1 min

Calibration frequency 1 kHz

Max. time of day drift max. 1.73 s in 24 h

Battery 2 x LR6/AA, 40 operation hours

External power supply via USB (see accessories)

Dimensions 266 mm x 76 mm x 38 mm

Weight 320 g (batteries inserted)

Reference conditions

Reference direction Handheld: 0 ◦, Outdoor: 90 ◦

Reference sound pressure level 94 dB

Reference frequency 1 kHz

Reference measuring range 25. . . 140 dB(A)

Reference air temperature 23 ◦C

Reference air pressure 101.325 kPa

Reference relative humidity 50 %

Table 4.1: Technical data Tango_Plus
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4.1 Microphone with capsule MK255

According to IEC 61672-1:2014 Tango_Plus has been tested under the following conditions:

Property value

Frequency range (Free field frequency response) 20 Hz bis 20 kHz

Level range section 3.6.1

Restriction of linear level range due to mechanical vibration section 3.4.1

Temperature range -10 ◦C bis 50 ◦C

Static air pressure 65 kPa bis 108 kPa

Relative humidity 25 % bis 80 %

Electrostatic discharge section 3.3.2

High frequency fields section 3.3.4

Mechanical vibration section 3.4.1

Apply signal via equivalent capacitance K65 (Microtech Gefell)

Table 4.2: Test conditions for Tango_Plus

4.1 Microphone with capsule MK255

Only the original microphone capsule MK255 by MICROTECH GEFELL is approved for measurements with
Tango_Plus. Data specific for configuration can be found in the sections 3.1 and 3.2. The acoustic center
point and microphone reference point are located at the middle of the microphone membrane.

Property Value

Model Transducer type Capacitive pressure transducer

Polarization backelectret

Frequency range free-field 3.5 Hz . . . 20 kHz (±2 dB)

Sensitivity ca. 50 mV/Pa

Max. SPL for 3 % , distortion at 1 kHz 146 dB

Self-generated noise with preamplifier 15 dBA

Capacitance 17 pF

Operating temperature range -50 . . . +100 ◦C

Ambient temperature coefficient leq0.01 dB/◦C

Ambient pressure coefficient -0.01 dB/kPa

Diameter 1/2”

with protection lid 13,2 ± 0,02 mm

without protection lid 12,7 ± 0,02 mm

Length 16,4 mm

Weight 7,5 g

Thread for preamplifier 11,7 mm 60 UNS

Thread for protection 12,7 mm 60 UNS

Table 4.3: Technical data MK255
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4 TECHNICAL SPECIFICATIONS

4.1.1 Random incidence and free-field correction

f Free field cor. Diffuse field cor.

in Hz in dB in dB

25 0 0

31.5 0 0

40 0 0

50 0 0

63 0 0

80 0 0

100 0 0

125 0 0

160 0 0

200 0 0

250 0 0

315 0 0

400 0 0

500 0 0

630 0 0

f Free field cor. Diffuse field cor.

in Hz in dB in dB

0.8 k 0 0

1 k 0 0

1.25 k -0.03 0

1.6 k 0.03 0

2 k 0.21 -0.1

2.5 k 0.36 -0.1

3.2 k 0.56 0

4 k 0.88 0.1

5 k 1.36 0.2

6.3 k 2.01 0.4

8 k 2.99 0.7

10 k 4.25 0.9

12.5 k 6.14 1.8

16 k 8.77 3.4

20 k 9.9 3.2

Table 4.4: Free-field and random incidence corrections (manufacturer’s specification: measurement uncertainty at 95% certainty ±0.6 dB)

4.1.2 Connection assembly of the detachable microphone

The microphone of Tango_Plus is detachable and connected to the analyser via LEMO plug FGG.1B.307 in
case FGC.1B.110.CZZ. The pin assignment is shown in figure 4.1.

Figure 4.1: Pin assignment for the detachable microphone

ATTENTION! The detachable microphone must be used only with the matched
Tango_Plus! Otherwise warranty is lost and it may be damaged.
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4.2 Optional Accessories

4.2 Optional Accessories

Optional Accessory Manufacturer Item number

Cal200 PCB, 1 kHz, 94 dB or 114 dB 800934.4

Type 4231 B&K, 1 kHz, 94 dB bzw. 114 dB 800043.2

USB power supply adaptor SINUS Messtechnik GmbH 601092.6

Table 4.5: Available accessories for Tango_Plus

4.3 Technical specifications of the calibrators

Feature Value

Standards IEC 60942:2003 and
IEC 60942:2017 and
ANSI S1.40-2006, Class 1

Sound pressure level 94 dB, 114 dB ±0.2 dB

Supported microphone types 1/2” with adapters for:
1/4”, 3/8”, 1/8”

Weight 156 g

Sound pressure stability <0.1 dB

Surrounding conditions

Static pressure 65 kPa . . . 108 kPa

Humidity 10% . . . 90% RH

Temperature -10 ◦C . . . + 50 ◦C

Table 4.6: Technical specifications Cal200

Feature Value

Standards IEC 60942:2003 and
ANSI S1.40-2006, Class 1

Sound pressure level 94 dB, 114 dB ±0.2 dB

Supported microphone types 1” with adapters for:
1/2”, 1/4”, 1/8”

Weight approx. 150 g

Sound pressure stability <0.05 dB

Surrounding conditions

Static pressure 65 kPa . . . 108 kPa

Humidity 10 % . . . 90 %RH

Temperature -10 ◦C . . . + 50 ◦C

Table 4.7: Technical specifications Type 4231
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5 DECLARATION OF CONFORMITY

5 Declaration of Conformity
We, SINUS Messtechnik GmbH, Foepplstrasse 13, 04347 Leipzig, Germany, declare that the product

Sound Level Meter Tango_Plus
Part Number: 907004.2
Serial Number:

to which this CE-declaration relates, is in conformity with the following standards and other documents:

Technical Parameters Sound Level Meter: IEC 61672 or DIN EN 61672-1:2014
DIN EN 45657

Third-octave analyzer: DIN EN 61260:2003 class 1

Electromagnetic Compatibiliy: Emission IEC 61000.6.3 or DIN EN 61000-6-3
IEC 61672 or DIN EN 61672

Immunity IEC 61000.6.2 or DIN EN 61000-6-2
IEC 61326 or DIN EN 61326
IEC 61672 or DIN EN 61672

Safety IEC 61010.1 or DIN EN 61010-1

The measuring system is intended for use with measuring microphones according to IEC 1094-1. This
product has been manufactured and tested in compliance with the following binding internal documentation
from SINUS Messtechnik GmbH:

Manufacturing and Testing documents: - Quality assurance manual
- Manufacturing documents for Tango_Plus
- Testing rules for Tango_Plus

This product was tested and found to comply with all specifications.

Gunther Papsdorf
Managing Director
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